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FREQUENTLY ASKED QUESTIONS
ACSELERATOR QUICKSET® SEL-5030 SOFTWARE 

acSELErator QuickSet® SEL-5030 Software is an easy-to-use yet powerful tool with 
template design capabilities for easy, consistent settings and applications to help 
you get the most out of your SEL device. This document provides common solutions 
to frequently asked questions about this product. If you have a question that is not 
addressed in this document or the provided solution does not work for you, please 
contact your local application engineer for more specific assistance.
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WHEN I INSTALL ONE DEVICE DRIVER IN SEL COMPASS®, MORE ITEMS ARE 
INSTALLED THAN I SELECTED.

Some device drivers require other plugins in order to use all the driver features. For 
instance, installation of the SEL-787 driver will also cause the download and installation 
of the Commissioning Assistant Software.

I CANNOT COMMUNICATE WITH MY SEL DEVICES IN QUICKSET WHEN USING 
A USB SERIAL ADAPTER.

A USB serial adapter is a common component of just about every new computer setup. 
These adapters are used to interface a personal computer (PC) with everything from 
QuickSet, HyperTerminal®, NMEA 0183 adapters and multiplexers, AIS receivers and 
transponders, and many other types of electronics. Most USB global positioning system 
(GPS) receivers, for example, each have an embedded USB serial adapter.

Several companies make the integrated circuits (“chips”) that form the core of a USB 
serial adapter. Each company provides special software, called a driver, that allows the 
Microsoft® Windows® operating system to detect and operate the USB serial adapter. 
If the appropriate driver has not been installed correctly in Windows, the USB serial 
adapter will not function or will not appear in QuickSet.

Driver software needs direct access to the hardware it controls (in this case, the USB 
serial adapter), so the operating system gives it special privileges. Unfortunately, these 
privileges make it possible for a driver to shut down the operating system when the 
driver misbehaves. Normal desktop applications do not have the same privileges, so an 
application crash does not affect the operating system and other running applications.

When a driver crashes, one of four things will usually happen: 

1. Intermittent communications errors occur during a read or send.

2. The computer reboots unexpectedly.

3. The computer completely locks up.

4. A blue screen (also called the “blue screen of death,” or BSOD) displays with a lot  
of technical-looking words and numbers.

If you experience communications errors, sudden reboots, complete lockups, or blue 
screen errors, a device driver could be responsible. Unfortunately, it is not always 
easy to determine which driver is at fault because every hardware component in your 
computer, including the display adapter, hard drives, keyboard, and mouse, uses a 
driver. Sometimes, following a reboot after a driver crash, Windows will offer to send 
a report about the crash to Microsoft. On rare occasions, you will receive a response 
indicating which driver caused problems. If you seem to only experience these prob-
lems when running QuickSet, a USB serial adapter driver is the mostly likely cause.

Your first step in trying to solve driver problems should be to check the website of the 
manufacturer whose device driver is causing the problem. Most manufacturers have 
support areas on their websites where you can download the latest drivers. If you  
need help determining which driver you need or with installing the driver, please 
contact the manufacturer of the device. SEL cannot offer support for devices from 
another manufacturer. The SEL-C662 USB-to-Serial Port Cable works more reliably 
with our products.  
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WHEN I SELECT UPDATES FOR ONLY A FEW DRIVERS IN SEL COMPASS, 
ALL PRESENTLY INSTALLED QUICKSET-RELATED PACKAGES ARE ALSO 
DOWNLOADED AND INSTALLED.

Some updates require that all QuickSet files be a specific version. For presently installed 
drivers to work, they must be at a specific version that is compatible with the main 
shell of QuickSet. Each driver must be updated, or the driver will not open or function 
correctly because of specific changes to the main shell of QuickSet.

HOW DO I DOWNLOAD QUICKSET FOR INSTALLATION ON A COMPUTER 
WITHOUT INTERNET ACCESS?

We have an offline installation file available for download at www.selinc.com/SEL-5030.  
You can use a computer with Internet access to download this file from the SEL website 
and copy the file to a removable thumb drive or CD. You can then take the removable 
media, copy the file onto the PC without Internet access, and run the file from there.

CAN I STILL SEND SETTINGS TO AN SEL DEVICE IN QUICKSET EVEN WHEN 
ERRORS ARE BEING REPORTED IN THE SETTINGS?

Yes. You can still send settings to an SEL device even when the Settings Editor shows 
that errors exist. Prior to sending settings with known errors, QuickSet displays a 
prompt asking whether you want to send these settings (see Figure 1).

If you select Yes and the values are valid for the SEL device, QuickSet accepts the 
settings. If the values are invalid, QuickSet might display an error message from the  
SEL device during the send process.

If you select No, QuickSet returns you to the Settings Editor, where you can adjust the 
settings changes to make them valid.

HOW DO I SAVE SETTINGS FOR A DEVICE WHEN I DO NOT HAVE THE 
ASSOCIATED DRIVER INSTALLED IN QUICKSET?

QuickSet has two ways of handling this kind of situation. One way is to use a universal 
driver, while the other is to give users an option to save the settings into the database 
and then open these files when the driver is installed.

The universal driver opens in a grid format, where you can save, modify, and send 
settings to a device. No error checking or graphical logic editor options are available 
for the universal driver, but users can still manage their settings. To use the universal 
driver option, the SEL device will have to be using File Transfer Protocol (FTP), Telnet, or 
Y-Modem. SEL devices that use ASCII transfer will be unable to use the universal driver.

To save settings during a read, choose Load Settings Without a Driver when QuickSet 
prompts that there is no driver installed. When you choose this option, QuickSet displays 
the settings in a grid editor. This editor has no error-checking features but allows you to 
make changes to the settings and save the settings to open later.

If you read settings for a driver that QuickSet supports but you do not presently have the 
driver installed, you can always install the driver after the settings are read from the 
device. After the driver is installed, it will then open the settings in the correct QuickSet 
Settings Editor.

Figure 1: Select Yes at the settings error prompt to  
accept the settings.
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WHY DO SOME DEVICE DRIVER SETTINGS EDITORS DISPLAY IN AN  
EASY-TO-VIEW GUI WINDOW WHILE OTHERS DISPLAY IN A MICROSOFT® 
EXCEL®-TYPE GRID EDITOR?

QuickSet uses two types of Settings Editors: one that we call a smart form editor  
(or GUI) and another that opens in a grid-type editor much like what you would see with 
an Excel spreadsheet. You can make changes, save, open, read, and even send settings 
using either editor. The main difference is that smart form editors provide error-
checking functionality along with other features, such as the graphical logic editor, 
while grid-type editors are just a means of storage for the settings.

HOW DO I BACK UP MY DEVICE MANAGER DATABASE AND ALL ASSOCIATED 
SETTINGS?

QuickSet uses two types of databases to manage settings and connections. The most 
commonly used database file is the relay database (RDB) file, which is standard on all 
QuickSet installations. After locating this file, it can be copied into a folder for storage 
and backup. By default, the RDB file is stored in the C:\Users\Username\AppData\
Roaming\SEL\AcSELerator\QuickSet folder and named Relay.rdb.

QuickSet uses the second database, a PostgreSQL database, for all Device Manager-
related settings and connections. Device Manager uses this database to store all of the 
information it needs to display the connection settings. You can choose to back up the 
Device Manager database because it is not stored in one file, as is the RDB file type. 
This option only backs up information stored in the Device Manager and does not back 
up any RDBs and settings stored outside of the Device Manager.

To back up the Device Manager database, navigate to File > Database Manager > 
AcSELerator Database and select the folder where you want to save the database. 
After selecting the backup folder, click the Backup Database button (see Figure 2).

If your database exceeds 10 gigabytes, then you will need to manually save the database 
folders as described in the FAQ on the acSELErator TEam® SEL-5045 Software webpage, 
located at www.selinc.com/SEL-5045. This FAQ document also includes instructions 
on restoring the database folders. Figure 2: Back up the Device Manager database.
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HOW CAN I IMPORT ALL OF MY SEL-5010 RELAY ASSISTANT SOFTWARE 
SETTINGS AND CONNECTIONS INTO QUICKSET?

Use the SEL.DataImporter tool to migrate your SEL-5010 connections and associated 
settings into QuickSet Device Manager connections. To import SEL-5010 connections 
and settings, you must first ensure that your SEL-5010 database is updated to version 
4.3.3 or newer.

The SEL.DataImporter tool can be found at C:\Program Files (x86)\SEL\AcSELerator\
QuickSet\bin\Plugins, as shown in Figure 3.

You can find more information on how to use the SEL.DataImporter tool under Section 9 
of the acSELErator QuickSet Instruction Manual, which you can download at  
www.selinc.com/SEL-5030 under the Product Literature tab.

IS QUICKSET FREE TO USE? I SEE A SECTION FOR LICENSING.

There are two versions of QuickSet: the base QuickSet program and another version 
(available with a license) that includes the Design Templates feature of QuickSet. For 
a chart describing features and outlining the differences between the two versions, 
visit www.selinc.com/SEL-5030. The free version of QuickSet includes everything 
necessary to manage your relays and associated settings. The Design Template feature 
provides the ability to develop Settings Editors for certain applications, allowing you  
to hide settings from end users and to determine the settings that can be changed in 
the editors.

For more information about QuickSet Design Templates, refer to Section 6 of the 
acSELErator QuickSet Instruction Manual, which can be downloaded from  
www.selinc.com/SEL-5030 under the Product Literature tab.

WHAT ARE THE DEFAULT PASSWORDS FOR THE DEVICE MANAGER LOGIN?

When you start the Device Manager, you will see a prompt for a user name and pass-
word to access the database. By default, User Name is admin and Password is blank, 
as shown in Figure 4.

 Figure 3: Locate the SEL.DataImporter tool.

 Figure 4: Enter admin for the User Name, and leave 
Password blank.
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WHY AM I RECEIVING A MESSAGE WHEN STARTING DEVICE MANAGER 
THAT STATES IT COULD NOT CONNECT TO THE ACSELERATOR DATABASE 
SERVICE?

acSELErator Database, a service installed with the Device Manager, will sometimes not 
start because of an IT department policy preventing automatic start of the service or 
because of errors in the Device Manager PostgresSQL database. If you right-click on 
the acSELErator Database service and select Start and the service still does not start, 
then the service was set during installation to start manually instead of automatically. 
Work with your IT department to set this to automatically start. If the acSELErator 
Database service still does not start, there may be errors in the PostgresSQL database.

To determine if the acSELErator Database service is running, navigate to Control  
Panel > Administrative Tools > Services to open the Windows services display.  
acSELErator is usually one of the top services listed in the Services window. The 
acSELErator Database service should display a status of Started.

WHAT DEVICES DOES QUICKSET SUPPORT?

From the SEL website at www.selinc.com/SEL-5030, you should see a list of supported 
devices that will open either grid or smart form editors in QuickSet.

WHERE IS THE QUICKSET ADDRESS BOOK, AND CAN I COPY ADDRESSES TO 
ANOTHER COMPUTER TO ALLOW ACCESS TO SAVED CONNECTIONS?

If you use the address book from the Communications Parameters window, QuickSet 
creates a text file that stores this information. You can then copy this text file onto 
another computer without having to recreate the network entries.

The Addressbook.txt file is located in C:\Users\Username\AppData\Roaming\SEL\
AcSELerator\QuickSet. To move the address book to another computer, you must 
copy the Addressbook.txt file into the same location on the other computer. If you do 
not have an AddressBook.txt file in this location, there are probably no saved network 
configurations for your QuickSet program. The text file is not created until the first 
saved connection.
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HOW DO I TRANSFER SAVED HMI CONFIGURATIONS SO THAT OTHER USERS 
SEE THE SAME HMI SCHEMES?

The HMI Configurations settings are stored in a Microsoft Access® database (MDB) file 
called HMIUserConfigurations.mdb at C:\Users\USERNAME\AppData\Roaming\SEL\
AcSELerator\QuickSet, as shown in Figure 5.

To share the HMI configurations of your QuickSet program, you will need to copy this 
database file into the same location on other PCs after you have made all necessary 
changes to the configurations. Keep in mind that copying this file to another PC will 
erase all other user configurations on that PC. We suggest that you back up the other 
HMIUserConfigurations.mdb files so that you can restore these configurations, if 
necessary.

HOW CAN I RECEIVE NOTIFICATIONS OF NEW QUICKSET VERSIONS?

SEL Compass has an option for notifying users of new versions for presently installed 
packages, including downloaded documents and installed SEL programs. To turn on 
this feature, open SEL Compass and navigate to Tools > Options. In the SEL Compass 
Options window, there is an Update Frequency section, as shown in Figure 6.

SEL Compass does not automatically install updates. However, if you have selected 
Enable Update Notifications and designated a timeframe when you want SEL Compass 
to look for new updates, the program will inform you of updates for documents and 
installed SEL software.

 Figure 5: Locate the HMIUserConfigurations.mdb file.

Figure 6: Select Enable Update Notifications, and choose a 
timeframe to be notified of updates.
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